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Overview

This article walks through the steps to import voters, vote history, and add elections from the state voter database (we have on file). This KB is
just for political campaign customers and would not work in the nonprofit product.

Note: As of the time this article was written we have these 19 states on file (from A to Z):

e Alaska

e Arkansas
e Colorado
e Florida

e Idaho

¢ Indiana

e Louisiana
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e Michigan

e Minnesota

e Missouri

e New Jersey

e New York

e North Carolina
e Ohio

e Oklahoma

e Rhode Island

e Vermont

e Washington

e Washington D.C.

U

¢« Tip: Use the Ctrl+F hot key to jump to different sections of this article (example: “#1”, “#2” or “Related Resources”.

Outline
#1 — Import ‘Voters’ from the State Voter Database into your Campaign’s Database
#2 — Import ‘Elections’ from the State Voter Database into your Campaign’s Database
#3 — Refreshing/Importing ‘Voter History’ from the State Voter Database into your Campaign’s Database
#4 — Related Resources
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#1 - Import ‘Voters’ from the State Voter Database into your Campaign’s Database

If you’re in a state where we have the voter roll on file you’ll see a link under the Application Menu in the upper-left that says something like ‘Your
State’ Voter List. /n my example is said Minnesota Voter List:
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@ Settings
Application Menu

Help

b Dashboard
[+ % Committee
» & Calendar/Tasks
[ % Canvassing
F % Voter
“oters
Minnesota Voter List
@j Addresses
@ Househalds
“oter Relationships
FU Lawn Signs
;- @@ Contributions/Pledges
5 % Product Sales
[ tf} Logs
47 Polling
I+ 2% Communications
[+ a Financial
I % Disclosure
[» % System Manager

If you're in a state that

we have the voter file

loaded for, it will display

here. (Ex: Minnesota Voter List)

Click on that link and then click [OK] to login. No credentials are required they’re already hard coded into the software.
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@ Settings  Help
Application Menu

Taszks

b Dashboard
i & Committee 1
» & Calendar/Tasks
[ % Canvassing

4 % Voter Logon - Trail Blazer Minnesota

EEl Voters

[ Minnesota Voter List Logon Information

@j Addresses User ID: |Trai| Blazer Guest

@ Househalds
EEl Yoter Relationships
FJ Lawn Signs
i W Contributions/Pledges
& £ Product Sales

Dé}Lags l

i &7 Polling

I+ % Communications
[ iﬂ Financial

[» % Disclosure

[» % System Manager

Passmrd drdririrdrdried
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Run a search query for the list of voters you want to import from the state database into your local db. In my example | searched for everyone who
voted in the last general election (2014), and lived in a specific precinct (Golden Valley P-1A) which produced 1,184 voter records (shown below).
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Build and run your search query for the voters you want to import from the state database into your campaign's database.

ot Settings  Help
Application Menu 0= | L) ¥ & 12| File » Edit - | 0 | @pInclude Other | Rename
El=&
flasks Favorites | General | 4 Address |)7 Vote History I Attribute | Lawn Sign | Cortribute | F‘Iedge|
[ Dashboard
[ % Committee @ |
i é :':::;gms @ (@ Address Types | Address | Addiional | District | User | Types |
4 B voter % a‘:{i‘;’i:‘g Display |7 | co: v PrecinctMame:  GOLDEN VALL =
Voters [#] Main Home k, S0 * Precinct Code: -
Minnesota Voter List [] Main \work LD: . Lomm/Folice |
@ Addresses [C] Other Home _ R e .
@) Households [C] Other work Vlard: City Council:
Voter Relationships [ Registration Scheal:
2 tawn signs Current Addresses
|- ¥y Contributions/Pledges
b % Product Sales
[ @ Logs
> & Poliing
1 5% Communications ) Sort () Format ~ 53 Wrap &% Export &Print [@] Surmmary D] B
& & Finandial o — :
v % Disclosure Last First Address e Zip Birth
B % System Manager I t i Mere e MI Type Street City State Code Date County D sD LD RegId
[ Import | 3114125 | Acken Anita Louise @) 3308 Noble Ave N Golden Valley | MN 55422 1/1/1936 || Hennepin 5 45 456 | 990452
[ Import | 3119086 | Adams Mary L @) 2815 Kyle Ave N Golden Valley MM 55422 1/1/1955 || Hennepin 5 45 458 | 998731
/ [mport | 386112 | Agee Chris Andrew @ | 1945 Major Dr Golden Valley | MM 55422 1/1/1974 || Hennepin 5 45 | 45B | 1592924
[ Import | 3113446 | Agee Loretta Henley @) 1945 Major Dr Golden Valley MM 55422 1/1/1941 || Hennepin 5 45 45E | 989455
Query RESUIts [ Import || 73270 Agnew Robert Steven @) 1800 York Ave N Golden Valley MM 55422 1/1/1952 || Hennepin 5 45 456 | 11068508
[ Import | 1516735 | Ahles Michel Marie @) 2912 Moble Ave N Golden Valley MM 55422 1/1/1965 || Hennepin 5 45 456 | 343132
[ Import || 73502 Akerson Karla Jean @) 1301 Waterford Dr Golden Valley MM 55422 1/1/1943 || Hennepin 5 45 45E | 1108908
[ Import | 2638894 | Aksan Alptekin @) 1375 Waterford Dr Golden Valley MM 55422 1/1/1969 || Hennepin 5 45 45B | 5059646
[ Import | 1523334 | Alcantara Cesar Velasco @) 3029 Golden Valley Rd Golden Valley MM 55422 1/1/1933 || Hennepin 5 45 456 | 3441205
[ Import | 1389555 | Aldrich Elizabeth | Rose @) 2135 Spruce Trl Golden Valley MM 55422 1/4/1%966 || Hennepin 5 45 458 3222154
[ Import | 805596 Aldrich leffrey Stephen @) 2135 Spruce Trl Golden Valley MM 55422 1/1/1965 || Hennepin 5 45 456 | 2283634
[ Import | 1610771 | Alexander Amber Marie @) 3116 Manor Dr Golden Valley MM 55422 1/1/1983 || Hennepin 5 45 456 | 3572108
[ Import | 76582 Alexander Nancy Eileen Wagner @] 1430 Skyline Dr Golden Valley MM 55422 1/4/1857 || Hennepin 5 45 458 | 1111209
[ 1mport | 1100 Alfton Dennis Lee @ 2555 Kyle Ave N Golden Valley | MM 55422 1/1/1951 || Hennepin 5 45 | 45B | 1000565
[ Import | 2140962 | Alfton Erica Jeanne @) 2555 Kyle Ave N Golden Valley | MN 55422 1/1/1989 || Hennepin 5 45 456 | 4449395
[ Import | 1833 Alfton Nancoy Jeanne @) 2555 Kyle Ave N Golden Valley | MN 55422 1/1/1950 || Hennepin 5 45 456 | 1001634
[ Import | 31141256 | Amdahl Agnes Louise @) 1930 Major Dr Golden Valley MM 55422 1/1/1935 || Hennepin 5 45 456 | 990454
[ Import | 1212461 | Amundson Holly Su @) 3344 Lee Ave M Golden Valley MM 55422 1/1/1965 || Hennepin 5 45 456 | 2940551
[ Import | 2645004 | Andersen Christian | Brian @J 2501 Meridian Dr Golden Valley MM 55422 1//1935 || Hennepin 5 45 458 | 5066031
[m 3040304 | Anderson Ann Marie @) 2211 Indiana Ave N Golden Valley MM 55422 1/1/1957 || Hennepin 5 45 456 | 886672
[ Import | 3114127 | Anderson Carol Marie @) 3100 Noble Ave N Golden Valley MM 55422 1/1/1942 || Hennepin 5 45 456 | 990456
[ Import | 31193958 | Anderson Carol 5 @) 3950 Bassett Creek Dr Golden Valley MM 55422 1/1/1941 || Hennepin 5 45 458 | 999222
m 180003 Anderson Dan Alan @) 3023 Golden Valley Rd Golden Walley MM 55422 1/1/1965 || Hennepin 5 45 456 | 1259542
b | 1 =1 I - N L L Fo e . L B P T | _ L I | |
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« Tip: You can ‘hand-import’ voters one-by-one if you click on the [Import] button next to their name in the grid. This is not as common as
running a mass import but can come in handy, here’s an example:
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<o Search % Reset | 9F Mew ™ | L) ¥ @ U= | File - Edit - | 0 | §mInclude Other | Rename
Favarites | General | 4 Address |)7 Wate Histany | Atribute | Lawn Sign | Contribute | F‘Iedgel
@ [} Address Types Address | Additional | Distict | User | Types
E E‘Ef?_”” Display | | o + PrecinciName:  GOLDENVALL =
ailing S Al
Main Home LS sh - Precinct Code: -
[ Main \werk LD: - (I,'om_m.l’ olice
[] Other Home TR B
[] Other \Work Ward: City Council:
[7] Registration Schoal:
Current Addresses
) Sort [ Format ~ 53 Wrap | % Export J Print @ Summary [[] = Pivot

Voters[TB Minnesota] [ 1184 records found |

Import D ha;; . I':':nt] . MI ?ydpde"’“ Street City State Eigd . gﬁ: County (D SO LD Regld
[ import | 3114135 | Acken Anita Louise @3 | 3308 Noble Ave N Golden Valley | MM | 55422 | 1/1/1936 || Hennepin |5 45 |458 |990452
[ import | 3119086 | Adams Mary L @h | 2815 kyle Ave N Golden Valley | MM | 55422 | 17171955 || Hennepin |5 45 |45 |998731
[ Import | zE6112 | Agee Chris Andrew @ | 1945 Major Dr GoldenValley |MMN | 55422 | 1711974 | Hennepin |5 45 |456 [1592924
[ Import | 3113446 | Agee Loretta Henley @y | 1945 Major Dr Golden Valley | MM | 55422 | 1/1/1941 || Hennepin |5 45 |45B |9a39468
[ import | 73270 | sanew Robert | Steven @ | 1800 York Ave N GoldenValley |MMN | 55422 | 1711952 | Hennepin |5 45 |45B |1106508
[ Import | 1516735 | Ahles Michel Marie @y | 2912 Noble Ave N Golden Valley | MM | 55422 | 1/1/1965 || Hennepin |5 45 |45B [343132
[lmr.lT] 73502 Akerson Karla lean @J 1301 Waterford Dr Golden Valley BN 55422 1/1/19453 || Hennepin 5 45 456 | 1106908
2638894 | Aksan Alptekin @ | 1375 waterford Dr GoldenValley |MMN | 55422 | 1/1/1969 | Hennepin |5 45 |45B |5059646
523334 | Alcantara Cesar Velasco @ 3029 Golden Valley Rd Golden Valley BN 55422 1/1/1933 || Hennepin 5 45 456 | 3441205

Tip: You can import records *one-at-a-time* by clicking on the [Import] button next to voter's name.
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To begin the mass import operation click on File > Import from State Database (in this case the Minnesota State Voter Database):
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s Search '@F{eset '-'-|']=~ Mew .. = |j '“l . File v| Edit ~ | g Sl.lnclude COther | Rename
@ Page Setup...
; ] p @ Print Preview
Favortes | General | 45 Address |)7 Wate History | Attribute | Lawn
@ & Print...
I E Create Map... 2
|il Address Types o i
@ - @ ]mport from Minnesota Voter database...
[7] Default Display & . o |
[C] Mailing i ' [ [
Ma?" Home * SD: T Prﬂcmﬂtilmpnrtfrum this databasel
[ Main \waerk LD -
[7] Other Home E——————
[ Other Work \ward: City Council:
[7] Registration Sehoal:
Current Addresses
B Sort B Format ~ =3 Wrap &% Export &Print @ Summary I:D B Pivot

Voters[TB Minnesota] [ 1184 records found ]

Import 1D Name Name MI %dp‘ir““ Street Street 2 City State (Z:'Ed . g'art: g:: County CD SD LD Reg

l: 3308 Moble Ave N Golden Valley ’W 55422 1/1/936 l— Henn... ’EL—I?IK 990452
[m 3119086 | Adams Mary L 2815 Kyle Ave N Golden Valley | MN | 55422 1/1/1955 Henn... |5 458 | 998731
[mport] 386112 | Agee Chris A @ 1945 Major Dr Golden Valley | MM | 55422 1/1/1974 Henn.. |5 |45 |458 |1592924 I
[mport] 3113446 | Agee Loretta Hel &3 | 1945 Major Dr Golden Valley | MN | 55422 1/1/1941 Henm.. |5 |45 |45B | 989468 I
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You have the option to import attributes which could be a wide range of things that your state board of elections might collect during an election
on their voters i.e. race, ethnicity, or more typically the source of the data. Check the box to import attributes if you want to bring them in, and
then click [OK]. In my example | select to import attributes along with all the other voter data.
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Import from Shared Trail Blazer Database

Included voters records will be imported from the shared
database "Minnesota Voter™ using the options specified
below.

Options
Import attributes

*If you want to Progress

import attributes Please press OK to proceed...
that are tied to
the voter's record
check this box.

Typically this will include
a 'source' attribute for
when the data was

initial uploaded into

our state DB.
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Depending on the size of the list you’re importing the operation could take anywhere from a few minutes to a few hours. In my case it was only
about 1k voters and took about 3 minutes. Trail Blazer will provide a load animation during the process as shown below.

Load status while the import is taking place.

Trail Blazer will merge any existing records together
if they're an exact match.

Impaort from Shared Trail Blazer Database @

Included voters records will be imported from the shared
database "Minnesota Voter™ using the options specified
below.

Import attributes I

Progress
|
Importing Voters - 125 processed, 25 imported.

@ o
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Once the process is complete you’ll get a popup message with the results. The system will automatically merge existing records during the import
if it’s an exact match with the voter record(s) already in your database, click [OK] to finish. In my example out of the 1k+ voters | was importing 283

were new.
[|: Impaort from Shared Trail Blazer Database @
. .
” _ncluded vaters records will be impodted from the shared
1 Result B ————— u

= .. | Results of 'new' voter
records imported.

You can now return to your own ‘voters’ list, and run the same search query to make sure the records were imported/updated correctly.

That completes the steps to mass import voters — continue reading to learn how to bring in new elections and voter history.
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#2 — Import ‘Elections’ from the State Voter Database into your Campaign’s Database

Your current list of ‘searchable’ elections will reside in the Voters list under the Vote History tab. My example is below where | had 12 elections in
my database.
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How to find the current list of elections in your database (if you have any).

@) Settings Help
Application Menu || <32 Search ¥ Reset | 4F New o | E o File ~ Edit = | &Include(}ther Voters

E[l& I

Ta Dashboard | Favorites | General | Address | Househol::i A Vote History Iﬁﬂnbi fte | Canvass | Fall | Relation | Lawn Sign | Contribite: | Pledge | Event | Sales | Log | Admin | saL |
[= boar
i &g Committee w |1 [

» & Calendar/Tasks © A lonct o — y - i
b @ Canvassing V @ Inclu... ection ote artisan
G voter O A Primary 2008 [votea ~ | Not Partisar v |
&l voters “— 1 In at least | lef12 General 2008 [Voted - | Mot Partisar V]
[8 Minnesota Voter List Primary 2010 [Voted w | Mot Partisar v]
@ Addresses E|
@ General 2010 [Voted ~ | Mot Partisar V]
Households i

[ voter Relationships

Pt Lown signs \ln my example I had 12 elections

Ep shared Databases

> @ Contributions/Pledges prior to importing more from the
b % Product Sales
state database.

i > Logs

b 7 Poliing EE Edit | Sort R Format - 53 Wrap | %% Export &% Print Detail |[@] Summary []] = | [&] Pivet

b b Communications Voters [ 46051 records found |

[» a Financial

» &% Disclosure D~ LastMName First Mame MI Address f‘i‘;‘:g"“ City State %fde g‘gs Gender

> G System Manager
131782 Cragun Leanne Eddington 2613 24th 5t NW Rochester MM 55901 1A/1957 | F
131781 Erennan Carolyn Ann 1625 County Rd No 24 Long Lake MM 55356 1/4/1953 | M
131780 Nagel Jason Robert 12125 Yukon Ave N Champlin MM 55316 111979 | F
131779 Asbu Tarik Beyene 1177 14th Ave SE Minneapolis MM 55414 141981 |F

To begin importing new/old elections from the state database navigate to the ‘Elections, Voter History List’ by following Application Menu >
System Manager > Lists > Elections, Voter History
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Navigate to the 'Elections, Voter History' list (requires admin security clearance).

@) Settings Help

Application Menu « | <30 Search %, Reset | 4k New = = File + Edit - | « | Voter Elections
1
E =& I3
Tasks Favortes | SQL
[ Dashboard
i &g Committee 1] |
- & Calendar/Tasks Favorite Searches
[ % Canvassing % o
» G voter i
» 7 Polling L8
i & Communications Jo
[ a Financial
[» % Disclosure
4 G System Manager L
System Gallery
4 [ Lists
=] Account Types B Sort [} Format ~ =3 Wrap EE Export & Print | B Pivot
o 1
i=| Candidat
=l Landicates Voter Elections [ 12 records found |
= Committee
o : = . Short Election Election Partisan  Import Code Water State
=l Election I Election Name Mame Date Type Election Format Count D
i=| Elections, Voter History
i 1 G 1 2005 11/8,2005 2 [ 11,/08,2005 4004 186
i=| Elections, Voting Types A B |1 2ENEMd <2 i ] A8,
= i
) Expenditure Refunds 2 | 09/13/2005 Primary 9/13/2005 |1 09/13/2005 1043 149
= Expenditure Categories 3 General 2004 11/2/2004 2 11,/02/2004 42697 176
i=| Event Participant Types 4 09/14/2004 Primary 91472004 |1 09,/14,2004 4262 152
5| Voter 5alutation Types 5 | General 2003 11/4/2003 |2 11/04,/2003 25432 179
(=l FEC Expenditure Categories 6 | 09/09/2003 Primary 9/9/2003 |1 09/09,2003 14 142
i=| Funds
W 7 G 1 2006 11/7/2006 2 [l 11,/07,/2006 29674 230
= Internal Import Columns = =ENEE =0 & =
2| Languages ) Primary 2006 9/12/2006 1 09/12,/2006 5254 227
=] Lawn Sign Types 9 | General 2010 11/2/2010 |2 11/02/2010 28853 442
= Lobbyists 10 Primary 2010 8/10/2010 1 08,/10,/2010 8634 4586
y=l Log Types 1 11 | General 2008 11/4/2008 |2 11/04,/2008 37875 857
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Select File > Import State Elections
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a Settings  Help

Application Menu «|| <39 Search W, Reset |4k New |3|E = | L) = @ {2 [File | Edit - | &) | Voter Hections
E |% @ Set Voter Counts
|
Tasks Favorites | gL Set Import Code
B Dashboard §
Import State Elections
[ % Committee @ | m i 2
5 Calendar/Tasks = -
avorite Searches . .
. % Canvassing ‘% | - [ Import state elections from Trail Blazer voter database i
[ % Voter et
» 47 Poliing *
I 5 Communications ’.E)
» i Finandal
[» % Disclosure
4 g System Manager L
System Gallery
4 [ Lists
=] Account Types B Sert [ Format ~ 53 Wrap |B§ Export & Print | 7 Pivot |
= Candidat
i=l tandiaates Voter Elections [ 12 records found |
i=| Committee
T ’ = ; Short Election Election Partisan  Import Code Woter State
Q Election I EleticniName Mame Date Type Election Format Count D
i=| Elections, Voter History =
- i |1 General 2005 11/8/2005 2 [ 11,/08/2005 4004 186
:=| Elections, Voting Types u E |1 =l — = _—
o [¥ H
{2 Expenditure Refunds 2 | 09/13/2005 Primary 9/13/2005 |1 09/13/2005 1043 149
2| Expenditure Categories 2 General 2004 11/2/2004 | 2 11/02/2004 42697 176
12| Event Participant Types 4 | 09/14/2004 Primary 9/14/2004 |1 09/14/2004 4262 152
@ Voter salutation Types 5 General 2003 11/4/2003 |2 11,/04/2003 7542 179
_ss FEC Expenditure Categories 6 09/09/2003 Prima 9,9/2003 1 09/09/2003 14
= Funds
k 7 | General 2006 11/7/2006 |2 11/07/2006 29574
:=| Internal Import Columns
12 Languages 8 | Primary 2006 9/12/2006 |1 09/12/2006 8254
12| Lawn Sign Types 9 General 2010 11/2/2010 |2 11/02/2010 28853
=] Lobbyists 10 | Primary 2010 81072010 |1 08/10/2010 3634
Y=l Log Types 11 | General 2008 11/4/2008 |2 11/04/2008 37875
M'“"_""”a' Types 12 | Primary 2008 9/9/2008 |1 09/09/2008 5967
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You’ll receive a popup message. Click [OK] to proceed with the selection of which elections to import.

Warning

Election records will be imperted from database
"TrailBlazer_USA_Minnesota”. Do you wish to proceed?

Click [OK] to proceed with the
selection of elections to import.

Check the boxes next to the elections you want to import, and then click [OK]. In my example | selected all the general and primary elections.
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No. of elections that are selected.

Flease select elections for import.

12 Election’s selected.

(] 02/27/2007 - SPECIAL (1D: 30)

[] 02/20/2007 AND 02/22/2007 - SPECIAL (1D: 25)
(] 0212/2007 AND 02/13/2007 - SPECIAL (ID: 15)
(7] 1212/2006 AND 12/1%/2006 - SPECIAL (ID: 156)
110772006 - GENERAL (1D: 139)

(] 10v23/2006 - SPECIAL (1D: 131)
091272006 - PRIMARY (10: 120)

1. ChECk the boxes [] 6711/2006 AND 07/12/2006 - SPECIAL (1D: 104)
[7] 0B/20v2006 - SCHOOL/SPECIAL (1D: 100)
H 053002006 - SPECIAL (1D: 93)
for the different E{E&&@I}DB-SPECIALUD:E?] |
' 05022006 -SPECAL(D.65
elections you want

to import into your 2 s eema|
local database. —————————————

It usually doesn’t take more than a few seconds for the process to finish. You'll receive a popup message with the results, click [OK] to continue. In
my example | imported 12 elections.
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After the operation has finished you'll receive a popup
message with the results.

. ==

Update cperation complete, 12 elections imported.

Click [Search] in the Elections, Voter History list to refresh it and display the new elections you imported. My example is below where | had 12
more elections for a total of 24.
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Click [Search] to refresh the list of elections in your database to view
the new ones that have been imported.

Favorite Searches

o ¥ B

(R Sort ) Format - 53 Wrap | ®% Export & Print | ) Pivot .

Short Election Election  Partisan
Name Date Type Election

General 2005 11/8/2005
09/13/2005 Primary 9/13/2005
General 2004 11/2/2004
09/14/2004 Primary 9/14/2004
General 2003 11/4/2003
09,/03,/2003 Primary 9/9/2003

General 2006 11/7/2006
Primary 2006 9/12/2006
General 2010 11/2/2010

Waoter
Count jin]

11,/08/2005 4004 186
09/13/2005 1043 149
11,/02/2004 42697 176
09/14/2004 4262 152
11,/04/2003 2542 179
05,08,/2003 14 142
11,/07/2006 29674 230
09/12/2006 8254 227
11,/02/2010 28853 442
08/10/2010 8634 436
11,/04/2008 37875 857
BrDSEEEE. tEiS
11,/04/2014 GEMERAL

08/12/2014 PRIMARY

08/13/2013 - PRIMARY
11/06/2012 - GENERAL
08/14/2012 - PRIMARY
11/02/2010 - GENERAL
08/10/2010 - PRIMARY
11,/04/2008 - GENERAL

.

D Election Name

Import Code Format

T
%

These are the new
elections that were
imported into my
database in my
*example.

Primary 2010 8/10/2010
General 2008 11/4/2008
pmaiiioan i i

11/04/2014 GEMERAL 11/4/2014
08/12/2014 PRIMARY 8/12/2014
08/13/2013 - PRIMARY 8/13/2013
11/06/2012 - GEMERAL 11/6/2012
08/14/2012 - PRIMARY 8/14/2012
11/02/2010 - GEMERAL 11/2/2010
08/10/2010 - PRIMARY 8/10/2010
11/04/2008 - GEMERAL 11/4/2008

. g

I S R i T i R T I
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That completes the steps. The following sections will show how to refresh voter history as well as setting the voter counts and vote percentages
en masse once everything else has been completed.

#3 — Refreshing/Importing ‘Voter History’ from the State Voter Database into your
Campaign’s Database

Navigate to the Voters list under the Application Menu.
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o-l  Settings  Help

Application Menu €
BB

Tasks

fs Dashboard
[» % Committee
» & Calendar/Tasks
[ % Canvassing
F @ Voter
Waters "‘—

Minnesota Voter List
@ Addresses
@ Househaolds
Yoter Relationships
r—U Lawn Signs
By shared Databases
- @ Contributions/Pledges
& (7 Product Sales
[+ fi:} Logs
47 Polling
I+ 55 Communications
> ¢iB Finandial
[ % Disclosure
i g System Manager

Click [Search] to load all the voters in your database OR run a search query for a segment of voters in your database. In my example | loaded all
72k.

KNOWLEDGE BASE www.trailblz.com/kb 26



http://www.trailblz.com/kb

& TrailBlazer

Organtze, Leverage. Succeed. How to Import Voters, Elections, and Voter History from the State Voter
Database into your Campaign’s Local Database — (Political Only)

KNOWLEDGE BASE www.trailblz.com/kb 27



http://www.trailblz.com/kb

9 TFCHIB’azer How to Import Voters, Elections, and Voter History from the State Voter
Database into your Campaign’s Local Database — (Political Only)

Organize, Leverage. Succeed.

Either load all voter records in your database OR run a search query

1 for a segment of

voters.

< Search s, Reset | New |[S|@E 5 | ) oF @ (| File - Edit - | & | SgInclude Other | Voters

¥
[

Favorites | General | Address | Household | Vate History | Attribute | Canvass | Pol

| Relation | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin | saL |

Name | Phone | E-Mail | Email Links | Profie | Work | Demographics | User, Text | User, Dates | User, Decimal | Other |

Q

Individual | Last Name:

,Seard'ia“rﬂ'riﬂarls

| Title:

Carporation First/Org Name:

- Voter List Load

PAC Middle Name:
Mickname:

Records to Load

Prior Last Name:

i Edit | Sort ) Format ~ 53 Wrap | 9% Export ¢ Prin|

72538 records found. Starting load dialog...

(2] & Last Name First Mame |

Search found 72,538 records. Of these, load:

i) Top @Al

Progress

/

I \wiaiting for user inpyf. ..

Zip Birth

state  coge  Date
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Follow File > Utilities > Import Voter History from State File

1

<39 Search Y. Reset | Jb New == File +| Edit ~ | ) | S Include Other | Voters
@ % Communications  »
Favories | General | Address | Household | Vote History | Attribute | C: ,% Reporting > _§ion | Contrinte | Pledae [ Fuent [ Sales [1on [ admin [ saL |
|%g  Utilities P& Export..
NHmE|th|E—Mﬂ|EnﬂLH{5|Pmﬂe|Woﬁ{|Demoga:ﬁ0q——q_-q—
@ _&. AlsaTaleTsd
' |@ Import Voting History from State File | 2
] Individual Last Name:
) —— Searchallname parts | = Delete
Corporation FirstiOrg Name: (anywhere in field) Import voting history from state file l
PAC Migdle Name: |8 Merge..
Nickname: =3 Find Possible Duplicates...
Prior Last Name: E{ Split Couples into Separate Voters..,
(B Sortin Househeld Walking List Order...

S8 Edit | Sort ) Format ~ 53 Wrap | ®% Export & Print @ Surmary [[] = |[E Pivot .

Voters [ 72538 records found ]
. Address ; Zip Birth
1D A Last Name First Mame I Address Line 2 City State Code Date Gender County
2 Aaberg Jamon lerome 3915 MNoble Ave N Robbinsdale MM 55422 1171971 | M Hennepin
3 Aaberg Kathrine Mary 3915 Moble Ave N Robbinsdale MM 55422 14/1965 | F Hennepin
Lr

Current count of voters in your list.
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Click [OK] to proceed with the operation. THIS MAY TAKE A LONG TIME (hours) TO RUN IF YOU HAVE MORE THAN 100k+ VOTERS IN YOUR LIST.

Warning

~  Voting history records will be imported from database
/_IA TrailBlazer_USA_Minnesota. Do you wish to proceed?

I oK I[ Cancel

You’ll get a load animation as the process runs.
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You'll get a load annimation that displays the status

of the voter history import/refresh. This process could
take a long time if you have over a 100k voters in the list.
Progress @

Progress

Importing: 3,000 voters processed, voting history imported for 2,121 voters
Running Time: 0.00:01.07

Cancel

When the operation has finished you’ll get a popup message with the results. Click [OK] to proceed. In my example about % (47k) out of the 70k
voters | had in my list had their voter history updated.
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You'll get a popup message when the operation has finished,
click [OK] to proceed.

@8 Import operation complete, voting history imported for 47,292 voters
W FRunning Time: 0.00:25:27

In my *example there
were about 47k voters
updated out of the 70k
I had in my list.

That completes the steps.

It’s not a requirement, but it’s a good idea to set your voter counts for the elections you imported. To do that return the Elections, Voter History
list, select File > Set Voter Counts
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&) Settings Help

Application Menu «/[ <3v Search . Reset | New = =) File -] Edit - | 0 | Voter Elections
|
E |E| | @ ‘ Set Voter Counts
1
Tasks Favorites Sl]_|L Set Import Code
I Dashboard i
Import State Elections
i+ g Committee @ | m P
> & Calendar/T | Favorite Searches
[ % Canvassing % =
[» % Voter i
b o Poliing p.8
&+ 4 Communications Jo
[ a Financial
[ % Disclosure
4 % System Manager i
System Gallery
4 [ Lists
= A tT -5 & i i
Ccco;z types ) Sort ) Format ~ 53 Wrap | &% Export ¢ Print | B Pivot |
Ca” '.:t = Voter Elections [ 24 records found |
ammittes
m . = . Short Election Election  Partisan Voter State
Election 1 jin] Election Mame Name Date Type Election Import Code Format Count o
=| Elections, Voter History ‘— =
4 i 12 2 [ 4004 186
Elections, Voting Types k - _
Expenditure Refunds 2 09/13/2005 Primary 9/13/2005 |1 09/13/2005 1043 149
=| Fxpenditure Categories 3 General 2004 11/2/2004 2 11/02/2004 42697 176
=| Event Participant Types 4 09/14/2004 Primary 9/14/2004 1 09/14,/2004 4262 152
Voter Salutation Types 5 General 2003 11/4/2003 |2 11/04/2003 2542 179
FEC Expenditure Categories 6 | 09/09/2003 Primary 9/9/2003 |1 09/09/2003 14 142
Funds
7 General 2006 11,/7/2006 2 11,/07/2006 29674 230
Internal Import Columns =
3 Languages B Primary 2008 9/12/2006 |1 09/12/2006 8254 277
Lawn Sign Types 9 General 2010 11/2/2000 |2 11/02/2010 28828 442
@ Lobbyists 10 Primary 2010 8/10/2010 1 08/10,/2010 8620 4586
=l Log Types 1 General 2008 11/4/2008 |2 11,/04/2008 37844 857
Memorial Types 12 | Primar 2008 9/9/2008 |1 09/09/2003 5954 492
Mations
13 11/04/3014 GEMERAL 11/4/2014 2 11,/04/2014 0 136
Mon-Monetary Types = =
Office Types 14 08/12/2014 PRIMARY a12/2014 |1 0812/2014 0 112
Payment Types 15 08/13/2013 - PRIMARY 8132013 |1 08/13/2013 0 113
Precincts 16 11/06/2012 - GEMERAL 11/6/2012 2 11,/06/2012 0 138
Relationships 17 | 08/14/2012 - PRIMARY 8/14/2012 |1 03/14/2012 0 114
= Shared Databases 18 | 11/02/2010 - GENERAL 11/2/2010 |2 11/02/2010 0 132
States/Provinces = —
X 19 08/10/2010 - PRIMARY 8/10/2010 1 08/10/2010 0 110
State Election Types = =
State Expenditure Categories 20 11,/04/2008 - GEMERAL 11/4/2008 2 11,/04/2008 0 135
| bk e bt i T 1 (I na ma onne - PRI ARY Q. Inne 9 Il na ng enne n 11E
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Click [OK] to proceed.

- Warning . - - - ‘

This functicn will set the voter count field for all elections, This process
may take a few minutes -- please be patient.

I ’ Cancel

Click [OK] again you receive a popup notification that the process has completed.

Woter counts updated,

KNOWLEDGE BASE www.trailblz.com/kb 34



http://www.trailblz.com/kb

& TrailBlazer

Organbe.Leverage. Succeed. How to Import Voters, Elections, and Voter History from the State Voter
Database into your Campaign’s Local Database — (Political Only)

Click [Search] to refresh the list and you’ll see the new voter counts for the elections you imported from the state database.
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Click [Search] to refresh the numbers in the grid for 'voter counts'
after you update them from the file drop-down menu.

Fawvorite Searches

o F W

- 53 al i i
@ Sort @ Format - =3 Wrap a Export &Prmt @ Pivot |

Voter Elections [ 24 records found ]

= . Short Election Election Partisan Import Cade Vater State
1D Eleciian]blame Mame Date Type Election Format Count jin]

» 1 General 2005 11/8/2005 11,/08/2005 4004 186

T

2 09/13/2005 Primary 9/13/2005 | 1 09/13/2005 1067 149
3 General 2004 11/2/2004 | 2 11/02/2004 42697 176
4 09/14/2004 Primary 9/14/2004 |1 09/14/2004 4284 152
5 General 2003 11/4/2003 | 2 11/04/2003 2542 179
[ 09/09/2003 Primary 9/9/2003 |1 09/09/2003 14 142
7 General 2006 11,/7/2006 | 2 11/07/2006 29674 230
8 Primary 2006 9/12/2006 |1 09/12/2006 5254 227
9 General 2010 11/2/2010 | 2 11/02/2010 28828 442
10 | Primary 2010 §/10/2010 |1 08/10/2010 8620 436
11 | General 2008 11/4/2008 | 2 11/04/2008 37844 857
12 Primary 2008 9,/9/2008 | 1 09,09,2008 5954 492
13 | 11/04/2014 GEMNERAL 11/4/2014 | 2 11/04/2014 32364 136
14 | 08/12/2014 PRIMARY 8/12/2014 |1 08/12/2014 5777 112

| 15 | 08/13/2013 - PRIMARY 8/13/2013 |1 08/13/2013 8 113
16 | 11/06/2012 - GENERAL 11/6/2012 | 2 11/06/2012 45401 138
17 | 08/14/2012 - PRIMARY 8/14/2012 |1 038/14/2012 5159 114 om fkb 36
18 | 11/02/2010 - GENERAL 11/2/2010 | 2 11/02/2010 33474 132
19 | 08/10/2010 - PRIMARY 8/10/2010 | 1 08/10/2010 9086 110
20 | 11/04/2008 - GENERAL 11/4/2008 | 2 11/04/2008 43963 135

' B =l | e e A A TR A A PR | Bl P — [ — - |
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Last but not least you’ll want to refresh the voter history percentages in your database.

Navigate to the Voters list, click [Search], select ‘load all’, and click [OK].
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2

o5 Settings  Help

Application Menu «|| <3 Search W, Reset | New |B|E 0= | L) ¥ # (2| File » Edit » | & | SpInclude Other | Voters

Bk & Q

L= | Favorites | Gensral | Address | Housshold | Vote History | Attribute | Canvass | Poll | Relation | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin | s0L |
i [ Dashboard

» G Committee Name | Phane | E-Mail | Email Links | Profile | Work | Demographics | User. Text | User, Dates | User, Decimal | Other |

» § calendar/Tasks 9

- I
» &g canvassing 1 N ’ : E _
sGgoer Clindvidial  [Lastiame Tite

EEl Vaters

) Search all name parts e
Corporation Fi : L i : M
[EH Minnesota Vater List Voter List Load E
@ Addresses PAC
I

@ Househalds Records to Load
[8F Voter Relationships B\ [search found 72,538 records. Of these, load:
PJ Lawn Signs
By Shared Databases

. @y Contributions/Pledges ) Top o

» % Product Sales

> Logs Progress
. 7 Poliing g Edit | Sort [ Format - 5 || \‘ .| | |
[ @ Communications 8 record W d tarting load | Waiﬁng for LISEI'iI'ﬂ.I't 3 I
x| Financial D Last state 2P Birth Gen- -
P % Disclosure Mame | : £ Code Date der ounty
[» System Manager
S [9) OK [ Cancel |

Follow Edit > Set > Update Voter History %
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1

<3 Search Y. Reset | New [S|E = | L) ¥ @ (2| File - Edit -[| & | SpInclude Other | Voters
@ |§E Set » | E%  Set Attributes..,
I
2] i =
Favortes | General |M¢ieas | Household | Wote History | Atribute I Canvass | fes T b |E% SetEvents. _ISQ—L‘
B¢ Assign  » |EZ setPall..
Name | Phone | E-Mail | Email Links | Profile | Workc | Demographics | User:wemey e _
@ =v  Set Fields...
' _ E%  Set MN Registered Voter ID
Individual Last Name: i
- . Search all name pa gé Infer/Set Gender
Corporation First'Org Name: {amywhere in figld)
=y -
PAC Middle Name: =¢  Make Voter Type Ind if not set
Mickname: %é Make Voter Type PAC if conditions met
[==1"4
Prior Last Name: =4 Sel Voter Type..

Update Vote History % | I 2

Create Lawn Sign Records...

= 5

=8 Edi - S5 & i i = Pi
EE Edit |@50r‘t @Format =3 Wrap | ﬁExport &Prmt | Summary ED B |Pwot |

Voters [ 72538 records found ]
. Addrass . Zip Birth
D 4 Last Mame First Mame MI Address Line 2 City State Code Date Gender County

u 2 Aaberg Jlamon lerome 3915 Moble Ave N Robbinsdale MM 55422 1/1/1971 | M Hennepin |
3 Aaberg Kathrine Mary 3915 Noble Ave N Robbinsdale Hennepin |
4 Aaberg Elorence 504 5th StE Starbuck Pope |
5 Aaker 20644 Justice Path Lakeville Dakota |
& Aalders icki 4756 Georgia Ave N Crystal Hennepin |
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Click [OK] when prompted. This may take many minutes or many hours depending on how many voters you have. In my example it took about
10 minutes for 70k voters.

Warning

~  This function will update and set the voter percent value, Do you wish
LE to proceed?

Click [OK] to proceed
with the voter history refresh.

(may take some time if you have over
a million voters in your databse)

The system won’t provide an update when the process is complete but it will give you a status bar as it’s underway. Once complete you can run
search queries by voter history for things like your ‘super voters’:
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o5l Settings  Help 3
Application Menu «|| <39 Search . Reset | 4k New o | oF @ File  Edit » | ) |8 Include Other | Voters

(ElRA= T

Taoahmu Favories | 4 General | Address | Household | Vote History | Attribute | Canvass | Pol | Refation | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin | saL |
[+ I
s Gy Committee | Name | Phone | E-Mail | Email Links | Frofie | Work || 4% Demographics 'Jser, Text | User, Dates | User, Decimal | Other |
» & Calendar/Tasks
> % Canvassing 0 ' 1
4 B voter ==& Age Range: 0 IZ" to |12'|] lZI Registration [{custum. according to dates below> v]
[0 voters = Birth Month: Ignare Daie: 5 Eice [ @

EB Minnesota WVoter List
Gender: Ignore = | Vote Percentage: tD
O Addreses : - S|

@ Households Head of Household

[BE Vvoter Relationships
Fu Lawn Signs
€z shared Databases
| ‘i Contributions/Pledges
b £ Product Sales

[» 'Cf} Logs
& 7 Polling =8 Edit &) Sort ) Format ~ =3 Wrap Dﬁ Export &Print @ Surmmary D] 8 [E Pivot [
b G Communications Voters [ 386 records found ]
» ¢l Financial
b % Disclosure ID 4 LastName First Name MI Address fi‘rj:tr;“ City State (Z:igde giart: Gender County
[ % System Manager
,_ Abel Gordon Eent 8500 56th Ave N Apt 38 MNew Hope W 55428 1/1/1949 | M Hennepin
406 Alfton Dennis Lee 2555 Kyle Ave N Golden Valley 55422 1/1/1951 | M Hennepin
407 Alfton Mancy leanne 2555 Kyle Ave N Galden Valley MM | 55422 1/1/1950 | F Hennepin
827 Ancier Leesann A 8209 Morthwood Plwy Mew Hope MM 55427 1/4,/1955 | F Hennepin
77 Anderson David B 2949 Hampshire Ave M Crystal MM 55427 1/1/1953 | M Hennepin
803 Anderson Donald B 3030 Scott Ave N Golden Valley MM 55422 1/1/1930 | M Hennepin

KNOWLEDGE BASE www.trailblz.com/kb 41



http://www.trailblz.com/kb

& TroilBlazer

Organbe.Leverage. Succeed. How to Import Voters, Elections, and Voter History from the State Voter
Database into your Campaign’s Local Database — (Political Only)

2%

Trail Blazer

- YouTube Channel
- Knowledge Base Articles
- 3rd Party Resources

Related Resources

Article: Running an Import of Contact Data from Excel into your Database — Basic Overview

Article: Start Import
Article: Import Templates
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Article: Pre-Import Check

Article: Field/Column Mapping When Importing Voter/Donor Data

Article: Import Information — Definitions and Column Data Type

Article: Importing District Information — from Non Registered Voters

Article: Importing Contributions

Article: Automatically Conform Addresses
Article: Auto-Merging Duplicate Address Records
Article: Address Management

Article: Why won’t some of my records merge

Article: Auto-Merge Duplicate Contact Records

Article: Address Normalization (unlimited addresses per person)
Article: Manually Merging Contact Records
Video: Importin 102 Importing your first list

Video: Attributes — Import with Date and Value

Video: Importing 102 Merge or Do Not Merge during import
Video: Importing 101 What to avoid
Video: Importing Contributions

Trail Blazer Live Support
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© Phone: 1-866-909-8700
® Email: support@trailblz.com

E? Facebook: https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
B Twitter: https://twitter.com/trailblazersoft

* As a policy we require that you have taken our intro training class before calling or emailing our live support team.
Click here to view our calendar for upcoming classes and events. Feel free to sign up other members on your team for the same training.

* After registering you’ll receive a confirmation email with the instructions for how to log into the GoToMeeting session where we host our live
interactive trainings.

* This service is included in your contract.
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